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Movavi Picverse

Activating Picverse
 
When you first start Movavi Picverse, it will be running in TRIAL MODE. You will be able to save 10 photos with the Movavi watermark. To
use the program without trial restrictions, you will need to buy a license and activate Movavi Picverse. If you don't have an activation key yet,
click the button below to visit our website and purchase one. See how

Activate the program
1.  Launch the program.
2.  At the top menu, select Activation — Activate software.
3.  Copy the activation key from your email and paste it into the activation dialog box.

https://www.movavi.com/picverse/buynow.html?asrc=pe_help
https://www.movavi.com/picverse/buynow.html?asrc=pe_help
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4.  Click Activate.

If you don't receive your activation key within an hour
• Check the Spam folder of your mailbox
• Contact support
 
Activating without Internet access
If the computer you have installed Movavi Picverse to is not connected to the Internet, you can activate the program via email.
See detailed instructions

Movavi Picverse

Getting an activation key
 
You can purchase an activation key from the official Movavi website or from any of our partners.
 
1.  Click the button below

2.  Choose a license type:
•  If you plan to use Movavi Picverse at home, click Buy Now on the purchase page.
•  If you plan to use Movavi Picverse at work, in a government institution, or gain profit in any way, go to the Business tab on the purchase
page, and click Buy Now.
 
3. Follow the instructions on the page and fill in your billing details. Don't forget to enter your real email address to receive your activation
key. All of our vendor partners are secure and completely safe.
 
4. After the purchase has been verified, you will receive an email containing your activation key. Now you can use it to activate the program.
 
Activation instructions
Activating without Internet access

If you don't receive your activation key within an hour:
•  Check the Spam folder of your mailbox
•  Contact support
Movavi Picverse

Activating without Internet
 
If your computer doesn't have internet access, you can still activate the license by email from any other device with internet access.
 
1.  Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to your email inbox. If you already
have a key, skip to the next step.

https://www.movavi.com/picverse/buy.html?asrc=pe_help
https://www.movavi.com/picverse/buy.html?asrc=pe_help
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2.  At the top menu, select Activation — Activate software.
3.  Copy the activation key from your email and paste it into the activation dialog box.
4.  Click Activate.

5.  In the step 1, click Copy and transfer this information to a device with internet connection.

6.  Create a new email, paste the copied message, and send it to reg@movavi.com. You should receive a reply within an hour.

7.  Copy the registration key from the reply and transfer it to the computer with Movavi Picverse installed.
8.  Return to the offline activation dialog box. If you've closed it, repeat steps 1-3 and enter the same activation key you used before. Then,
paste the registration key into the box and click Activate.

https://www.movavi.com/picverse/buy.html?asrc=pe_help
https://www.movavi.com/picverse/buy.html?asrc=pe_help
mailto:reg@movavi.com
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If the activation is unsuccessful
• Make sure that you have entered the activation key correctly. There should be no additional characters or spaces after the last digit.
• Also make sure that the key you used is meant for Movavi Picverse.
• Before attempting to activate, deactivate your antivirus software and firewall.
• Check that your user account has administrator privileges.
• If none of the above solves the problem, contact our support team.
Movavi Picverse

Managing subscription
 
If your subscription has expired, you need to renew it to continue using the program.

1.  To renew your subscription, click Renew Subscription.
2.  A web page will open, where you can buy a new subscription. After the purchase, you'll receive an activation key in an email.
3.  Copy the key and paste it into the program window. Then click Activate.

Having problems with activation?
•  Make sure you have entered the activation key correctly and try again
•  Check that you are activating the right application
•  Make sure you have administrator rights on your computer
•  If you haven't receive the key within an hour, check the Spam folder of your mailbox
 
If you have any questions or problems while activating your Movavi software, feel free to contact us and we'll help you out!
Contact support team
Movavi Picverse

Managing photos
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You can upload your photo collection to Movavi Picverse and manage them more comfortably and quickly.
 
Uploading photos
At first startup, you will see a welcome screen. Click Open Files or Folders to add files to your Gallery. Or just drag and drop them into the
window.

Now you can see all your added photos on the All Photos tab. The program will automatically detect people on your photos and create
albums with them. If your photos have a geotag, they will also be automatically sorted by places on the Places tab.

Viewing photos
Double-click a photo to view and edit it.

Sorting and ordering your collection
You can sort photos in the Gallery and put them in descending or ascending order. Click a filter and select the one you need.
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Enlarge photo previews by moving the size-changing slider at the top bar.

Select photos by selecting a date checkbox above a group of photos. Or just click photos one by one.

 
See also
Creating albums
Bin
Movavi Picverse

Creating albums
 
1.  Select photos to create an album. Click photos one by one to select multiple separate images. Hold Shift and click the first and the last
image in a range you want to select. You can also select a checkbox with a date, and all photos of this period will be selected.
2.  Click the Create Album icon at the top bar.
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3.  Enter a name of your album.
4.  Click Create.

5.  Find your album in the album list.

 
Adding photos to an album
1.  Select photos you want to add to an album.
2.  Right-click any of the selected photos and choose Add to Album.
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3.  In the window, choose an album and click it.

Movavi Picverse

Bin
 
When you delete photos, they go into a Bin. There they are stored for 30 days by default and then are automatically deleted. You can change
this setting in the Preferences window on the Files tab. Each photo has an individual counter which shows in how many days a photo will be
deleted permanently.

Deleting images from the program
1.  Select images you want to delete from the program completely.
2.  Right-click an image and select Delete Permanently from the menu.



 

10

If you want to delete all the photos, deselect all and click Empty in at the top.

Restoring images
1.  Select images you want to restore to the Gallery.
2.  Click the Restore button at the top. Or right-click an image and select Restore from the menu.

Movavi Picverse

Opening images
 
Drag-and-drop
Find the necessary image in Windows Explorer and then drag it from Windows Explorer right onto the Movavi Picverse window.
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Browse
On the start screen, click Open photo. A Windows Explorer dialog box will appear. There, choose the file you want to edit and click Open.

Open photo button

Click the open photo  icon in the upper left corner of the window. A Windows Explorer dialog box will appear. There, choose the file you
want to edit and click Open.

Recent file
On the start screen, click Last edited file. The thumbnail next to it shows which image was opened last.
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File menu
Open the File menu and select Open. A Windows Explorer dialog box will appear. There, choose the file you want to edit and click Open.

 
 

See also
Saving images
Movavi Picverse

Zoom and navigation

Zoom
When you open an image, it will be fitted to the window size. Use the zoom and navigation tools at the bottom of the window to set a
comfortable view.

Fit to screen – adjusts the zoom level so that the entire image can fit in the window.

Actual size – sets the zoom level to 100%, displaying the image as it is.

Hand tool – to move an image around while zoomed in, click the hand icon and hold the left mouse button to move the
image. Then, click the hand icon again to go back into editing mode. You can also drag the image by holding the left mouse
button and Space on your keyboard.
To magnify an image, use the zoom slider at the bottom of the window. You can also zoom in and out using the mouse
wheel.

 
 

Navigation
Now you can sort through entire photo folders and edit their contents on the fly. Use the tools at the bottom of the window:

Go to the previous image in the folder.

Go to the next image in the folder.

Click to view all the images in the folder.

 
As well as file navigation buttons at the top:
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Click to compare your working copy with the original image.

Click and hold to view the original image before editing.

Switch to managing mode, where you can sort your entire collection.

Switch to editing mode, where you can edit photos.

Movavi Picverse

Adjustments

Automatic adjustments
You can enhance contrast and brightness automatically. On the Adjust tab, click Automatically.

 
Manual adjustments
If you need more specific adjustments, click Manually on the Adjust tab. Adjust the sliders in the settings. To reset a setting double-click a
slider.
 
Adjusting a specific part of an image
If you want to change a specific part of your photo, use the selection tools. Set new adjustments and they will be applied only to the selected
area.

Selection brush — select objects freely

Magic wand tool — quickly select objects of the same color

Lasso tool — select an object by tracing its outline

Polygonal lasso tool — select an object by tracing its outline using straight lines

Rectangular marquee tool — select a rectangular part of the image

Selection eraser — deselect areas
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Restoration of old photos
1.  Click Restoration of old photos on the Editing tab.

2.  Switch on the Restore option and click Apply. Select Colorize photo if you want to turn your black and white photo colored and then also
click Apply.

Automatic adjustments
The HDR Lighting slider automatically adjusts the brightness and contrast, highlighting both dark and light parts of the image.
The Enhance slider sets the best value for each color correction setting. Tweak the effect using sliders.
The Denoise slider lets you remove any digital noise in the photo.
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Light
Exposure
In photography, exposure is the amount of light allowed to reach the camera's sensor, which is usually achieved using a combination of
shutter speed, aperture, and lighting. If there is too much light on average, you may lose some details in the dark parts, while the light areas
may become "washed-out", and vice versa. This allows you to imitate a higher or lower exposure as if you set it on your camera when taking
the shot.
 
Brightness
Allows you to change the overall amount of light in the whole image without changing any other parameters.
 
Contrast
Allows you to change the difference between the lightest and darkest parts of the image. It can help you make the image more vivid, but too
much contrast can cause unwanted posterization.
 
Highlights and shadows
These two sliders allow you to make each component more prominent in the image and make the image darker or brighter.

Color
White balance
White balance lets you remove unrealistic color casts so that objects which appear white in person are rendered white in your photo.
Click Color and then click the color picker icon. Then in the picture, select a color that you want to be considered as white. The white balance
will be adjusted automatically.
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Temperature
Allows you to make the image feel warmer or colder by adding orange or blue color respectively.
 
Tint
Allows you to add a red or green tone to the image, either for color correction or for an artistic feeling.
 
Hue
Allows you to change an image's overall color. Unlike tinting or color temperature (see below), changing an image's hue will not color the
picture in shades of one color. Instead, it will shift all the image's colors in a given direction.
 
Saturation
Allows you to make the colors richer (positive values) or more subdued (negative values). Settings Saturation to -100 will make the image
grayscale. 
 
Vibrance
Like saturation, vibrance makes colors richer but affects only subdued tones and doesn't affect already saturated colors. Vibrance is less
likely to twitch skin color to unrealistic shades.
 
 
Details
Sharpness
Allows you to sharpen the image. Please be aware that oversharpening an image can add noise.
 
Details
Allows you to bring out more details in an image.
 
Blur
Allows you to slightly blur the image to reduce noise or smoothen out defects.

 
Movavi Picverse

Erasing objects
 
1.  On the right side of the window, click the Erasing objects icon.
2.  Select the objects you wish to erase — people, animals, cars, objects or anything else that you don't want to see in the image. Learn how to
erase objects automatically and how to do it manually.

Tip
If you need to erase several objects, you can select them all at once or erase them one by one.
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Movavi Picverse

Erasing objects automatically
 
1.  In the Erasing objects tool, select Automatically.

2.  Click an object you want to erase. If the object is complex and the program cannot select it after just one click, or there are several
objects, click the unselected parts until they are highlighted in red. Adjust the Selection area slider to control the size of the area that will
be highlighted. Hold the Ctrl key and click the selected area to remove an unwanted selection. To clear all selections from the image, click
Reset.
 
3.  When you select the entire object, click Erase. The processing might take up to several minutes if the selected area is too big. If you don't

like the result, click the Undo button  at the top panel, adjust the selection area and try again.

4.  If you see some distortions in the picture, you can fix them by hand. Switch to the Manual tab. Use a brush or a lasso to select distorted
areas and click Erase again. Repeat until all distortion is fixed.

Movavi Picverse

Erasing objects manually
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1.  In the Erasing objects tool, select Manually.

2.  Use any selection tool to mark the object you want to delete.

With a brush you can mark the selection area freely. Use the brush size slider to adjust the brush.

Click on an area with a magic wand, and all adjacent areas of uniform color will be selected.

Create a starting point with a lasso and move your cursor around the object's outline. Then bring the cursor
closer to the starting point but from the other side, and the selection will be created.

With a polygonal lasso, you can outline an object with straight lines. Set a starting point, create a line,
and click to fix it. Do this until you're back to the starting point, and bring the cursor close to it to create a
selection.

Use an eraser to deselect parts of the image. Just like with the brush, you can change eraser size with a
slider. The eraser only affects your selection and does not erase objects in the photo.

Use a stamp to select a part of the image to transfer onto another part of the image. You can also use the
stamp to mask small blemishes or duplicate objects.
Learn more about clone stamp retouching

 
3.  Select objects you want to erase. Don't forget about their reflections and shadows. Adjust the Selection area slider to change the size of
the area that will be selected. To remove an unwanted selection, use the eraser or click Reset to clear all selections from the image.
 
4.  Click Erase. The processing might take up to several minutes if the selected area is too big. If you don't like the result, click the Undo

button  at the top panel, adjust the selection area and try again.

5.  If you see some distortions in the picture, use a brush or a lasso to select distorted areas and click Erase again. Repeat until all the
distortion is fixed.
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Changing background
 
1.  On the right side of the window, click the Change Background icon.
2.  Select the objects that you want to transfer to a new background. You can do it automatically or manually. Background change has several
steps of refining the selection, so if you don't get a perfect selection on the first step, you will get a chance to do it later.
3.  See how to how to select objects automatically or how to do it manually.

 
 

Movavi Picverse

Selecting objects automatically
 
1.  Click Automatically on the Removing background tab. The program will detect all objects that stand out from the background.

2.  If you like the result, select a new background. You can replace it with a plain color from the palette, an image from the built-in collection,
or your image. To add a new photo to the background, switch to the Image tab. There, click the plus to select your photo.
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3.  Click Finish, if everything is okay, or click Edit to adjust the selection, erase or restore areas.
 
Edit selected objects
1.  Decide what you need to do. You can restore or erase whole areas and tiny details. The tools on the Areas tab work best with bigger areas
of an image, and the Details tab is perfect for selecting hair and fur.

2.  Click Apply to save edits and return to selecting a new background.

3.  Click and drag the objects to place them where you want them, and drag the red dots of the frame to resize and rotate.
4.  Click Finish.
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Movavi Picverse

Selecting objects manually
 
1.  Click Manually on the Removing background tab.

2.  Click the objects you want to transfer to a new background. You might need to click several times and adjust the selection settings to get
the best result. Hold the Ctrl key and click an area to remove any unwanted selection. Once you've selected the objects, click Continue.

3.  If you are satisfied with the result, select a new background. You can replace it with a plain color from the palette, an image from the built-
in collection, or your image. To add a new photo to the background, switch to the Image tab. There, click the plus to select your photo
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4.  Click Finish, if everything is okay, or click Edit to adjust the selection, remove or restore areas.
 
Edit selected objects
1.  Decide what you need to do. You can restore or erase whole areas and tiny details. The tools on the Areas tab work best with bigger areas
of an image, and the Details tab is perfect for selecting hair and fur.

2.  Click Apply to save edits and return to selecting a new background.

3.  Click and drag the objects to place them where you want them, and drag the red dots of the frame to resize and rotate.
4.  Click Finish.
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Inserting images
 
1.  On the right side of the window, click the Insert Image icon.

2.  To insert a new image, click Paste an Image. To copy and paste an area of the same photo, select it with any selection tool:

Use rectangular marquee to select a rectangular part of an image.

Use lasso to select an object by freely tracing its outline.

Use polygonal lasso to select an object with straight edges by tracing its outline with lines.

3.  Then click  to copy the selection and then  to paste it. You can also cut  the selected area from the picture.
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4.  The image will be inserted. Change its size by dragging the corners of the frame, and place it where you need it.
5.  Set other options of the inserted image. Adjust the Opacity slider, Outline width and color. Add Shadow if needed, and adjust its color,
angle, and blur.
     If you used the rectangular marquee to select an area, you could also round the corners of the selection using the Rounded corners slider.

     
6.  Click Apply to save changes or Reset to discard all settings and the inserted image. Once you apply the image, you cannot make any more
changes to it.
 
Movavi Picverse

Retouching
 
Use the retouching tools to get rid of small imperfections and apply make-up effects to your portraits.

Go to Retouching.
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You can choose to retouch the photo automatically or manually. If you select automatically, the program will do some adjustments itself.
But you can still decide to do all changes manually, then the program will take you to all the retouching tools. Learn how to use them in the
articles below.

Learn more

Skin smoothing Eyeshadow

Wrinkle removal Mascara

Blemish removal Eyebrow pencil

Shine removal Lip color

Foundation Teeth whitening

Blush Hair color

Red eye removal Face slimming

Eye enlargement Reshaping tools

Eye color Clone stamp retouching

Movavi Picverse

Skin smoothing
 
1.  Choose Skin smoothing from the Skin section on the right-hand panel.
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2.  Adjust the brush size and its softness using the Brush size and Brush softness sliders.
3.  Set the tool intensity using the Smoothing intensity slider. You can also apply the effect first and then change the intensity.

4.  Then paint along the skin to smooth it. Use the eraser  to remove smoothing from any excess areas.
5.  Click Apply to save the changes. To discard the changes, click Reset.
 
Tip: you can change the intensity after applying the effect.

Movavi Picverse

Wrinkle removal
 
1.  Choose Wrinkle removal from the Skin section on the right-hand panel.

2.  Adjust the brush size and softness using the Brush size and Brush softness sliders on the right-hand panel.
3.  Set the tool intensity using the Intensity slider.
4.  Then paint along the wrinkle to erase it.
5.  Click Apply to save the changes. To discard the changes, click Reset.
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See also
Blemish removal
Movavi Picverse

Blemish removal
 
1.  Choose Blemish removal from the Skin section on the right-hand panel.

2.  Adjust the brush size using the Brush size slider on the right-hand panel. Set the brush size slightly larger than the blemish you want to
remove. Then click the blemish to erase it.
3.  Click Apply to save the changes. To discard the changes, click Reset.

See also
Clone stamp retouching
Movavi Picverse

Shine removal
 
1.  Choose Shine removal from the Skin section on the right-hand panel.
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2.  Click the Remove Automatically button on the right-hand panel to remove excess shine from the portrait.

If the program can't recognize the face automatically or you're dissatisfied with the result, you can use the manual mode. Adjust the brush
size using the Brush size slider on the right-hand panel. Then paint the skin to make it less shiny.
 
3.  Click Apply to save the changes. To discard the changes, click Reset.

Movavi Picverse

Foundation
 
1.  Choose Foundation from the Skin section on the right-hand panel.
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2.  Choose a color and set its intensity using the Color intensity slider.
3.  Adjust the brush size and its softness using the Brush size and Brush softness sliders.

4.  Then paint along the face to color it. Use the eraser  to remove any excess color. You can also apply the effect first and then change
the color.
5.  Click Apply to save the changes. To discard the changes, click Reset.

Movavi Picverse

Blush
 
1.  Choose Blush from the Skin section on the right-hand panel.

2.  Choose a color and set its intensity using the Color intensity slider. You can also apply the effect first and then change the color.
3.  Adjust the brush size and its softness using the Brush size and Brush softness sliders.

4.  Then paint along the cheekbones to color them. Use the eraser  to remove any excess color.
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5.  Click Apply to save the changes. To discard the changes, click Reset.

Movavi Picverse

Red eye removal
 
1.  Choose Red eye removal from the Eyes section on the right-hand panel.

2.  Click the Remove Automatically button on the right-hand panel to remove the red eye effect.
If the program can't recognize the face automatically or you're dissatisfied with the result, you can use the manual mode. Adjust the brush
size using the Brush size slider on the right-hand panel. Set the brush size to slightly larger than the pupil. Then simply click the pupil to
remove the red eye effect.
3.  Click Apply to save changes. To revert changes click the Reset button.

 
Movavi Picverse

Eye enlargement
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1.  Choose Eye enlargement from the Eyes section on the right-hand panel.

2.  The face recognition process will start automatically. Wait until you see the "Face(s) recognized successfully" message pop up on top of
the image.
3.  Click Enlarge.
4.  Move the Intensity slider to adjust the effect.
5.  Drag the Intensity slider to adjust the effect.
6.  Click Apply to save changes. To revert changes click Reset.

Movavi Picverse

Eye color
 
1.  Choose Eye color from the Eyes section on the right-hand panel.
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2.  Choose a color, set its intensity and brush size using the sliders on the right-hand panel. Make sure to set the brush size slightly larger than

the iris. Then click the iris to recolor it. Use the Eraser  to remove excess color from the pupil or the surrounding areas. You can also apply
the effect first and then change the color.
 
3.  Click Apply to save the changes. To discard the changes, click Reset.

Movavi Picverse

Eyeshadow
 
1.  Choose Eyeshadow from the Eyes section on the right-hand panel.

2.  Choose the eyeshadow color and set its intensity using the Color intensity slider. You can also apply the effect first and then change the
color.
3.  Adjust the brush size and its softness using the Brush size and Brush softness sliders.

4.  Then paint along the eyelids to color them. You can use the eraser  to remove excess color.
5.  Click Apply to save the changes. To discard the changes, click Reset.



 

33

Movavi Picverse

Mascara
 
1.  Choose Mascara from the Eyes section on the right-hand panel.

2.  Set brush size and color intensity. Make sure that the brush diameter is slightly larger than eyelash length. Then paint along the eyelid

to color in the lashes. Use the eraser  to remove excess color from the surrounding areas. You can also apply the effect first and then
change the color and intensity.
 
3.  Click Apply to save the changes. To discard the changes, click Reset.

Movavi Picverse
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Eyebrow pencil
 
1.  Choose Eyebrow pencil from the Eyes section on the right-hand panel.

2.  Choose a color that matches the eyebrow color on your portrait and set its intensity using the Color intensity slider. You can also apply the
effect first and then change the color and intensity.
3.  Set brush size and softness using the Brush size and Brush softness sliders on the right-hand panel.

4.  Then paint along the eyebrows to color them. Use the eraser  to remove excess color from the surrounding areas.
5.  Click Apply to save the changes. To discard the changes, click Reset.

Movavi Picverse

Lip color
 
1.  Choose Lip color from the Mouth section on the right-hand panel.
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2.  Choose a color you want and set its intensity using the Color intensity slider. You can also apply the effect first and then change the color
and intensity.
3.  Set brush size and softness using the Brush size and Brush softness sliders on the right-hand panel.

4.  Then paint along the lips to recolor them. Use the eraser  to remove excess color from the surrounding areas.
5.  Click Apply to save the changes. To discard the changes, click Reset.

Movavi Picverse

Teeth whitening
 
1.  To open teeth whitening tools choose Teeth whitening from the Mouth section on the right-hand panel.
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2.  Set brush size and color intensity on the right-hand panel. Then paint along the teeth to whiten them. You can adjust intensity after
painting.
3.  Click Apply to save changes. To revert changes click the Reset button.

Movavi Picverse

Hair color
 
1.  Choose Hair color from the Others section on the right-hand panel.

2.  Choose a color, set its intensity and brush size and softness using the sliders on the right-hand panel. Then paint along the hair to color

it. Use the eraser  to remove excess color from the surrounding areas. You can also apply the effect first and then change the color and
intensity.
3.  Click Apply to save the changes. To discard the changes, click Reset.

Movavi Picverse
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Face slimming
 
1.  Choose Face slimming from the Others section on the right-hand panel.

2.  The face recognition process will start automatically. Wait until you see the "Face(s) recognized successfully" message pop up on top of
the image. If there are several faces in the photo, click the one you want to apply the effect.
3.  Click the Slim Down button on the right-hand panel.
4.  Drag the Intensity slider to adjust the effect.
5.  Click Apply to save changes. To revert changes click Reset.

 
Movavi Picverse

Reshaping tools
 
1.  Choose Reshaping tools from the Others section on the right-hand panel.
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2.  Select one of the reshaping tools:

Reshaping Brush — moves pixels with the movement of the brush. Click and hold on the object you want to
reshape. Then drag the brush as if you were stretching the object.

Shrinking Brush — moves pixels towards the center of the brush. Click on the object you want to shrink using
this tool.

Enlarging Brush — moves pixels away from the center of the brush. Click on the object you want to enlarge
using this tool.

 
3. Change the object's shape using the selected tool. You can adjust Brush size and Intensity for each tool.
4. Click Apply to save changes. To revert changes, click the Reset button.

Movavi Picverse

Clone stamp retouching
 
The clone stamp helps to eliminate blemishes, wrinkles, and other minor imperfections of the image or to clone objects.
 
1.  Click the Erasing objects icon.
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2.  On the Manual tab, select the stamp tool.

3.  Use the Stamp size slider beneath the tool icons to set the stamp's size. Increasing Stamp softness will make the stamp's edges more
transparent, which can help you blend the stamped parts with the rest of the image.

4.  Move your mouse pointer over to the area you want to clone (for example, a similar area without blemishes). Hold down the Alt key and
click the image to create a source point.
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5.  Release the Alt key. Then, move your mouse pointer to where you want the cloned fragment to appear and paint over the area you wish to
replace. The sampled area will also move relative to your pointer position as you move it while painting with the stamp. Try to replace smaller
areas, as this will help to avoid significant visual differences of the area.

Movavi Picverse

Effects
 
1.  On the right side of the window, click the Effects icon.

2.  Click on Popular to see the list of effect groups. Click on a group to open it and show the relevant effects.
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3.  Choose an effect you like and click it.

4.  For some effects, you can use the Intensity slider under the effect's thumbnail to modify its strength or detail level. To apply an effect,
click the checkmark button under the thumbnail.

Tip: You can apply multiple effects to one photo.
 
Removing effects
To remove an applied effect, click the cross button under the thumbnail or click it once more.
Movavi Picverse

Crop, rotate, resize
 
On the Tools tab, select the Size tool. From there you can crop, rotate, and resize the image.



 

42

Cropping images
Rotating images
Resizing images

Movavi Picverse

Cropping images
 
Open the Crop tab.

There are several ways to crop an image. You can change the frame, enter specific numbers or use a fixed aspect ratio.
 
Cropping frame
Drag the corners of the frame to an area that you want to keep. The rest will be cropped out.
 
Manual input
If you need a specific size in pixels, you can manually enter the width and height into the boxes. To switch the values of width and height,

click the Invert proportions  icon. You can select to lock the aspect ratio by clicking the lock  icon. This way, when you change one
dimension of the cropping frame, the other dimension will change accordingly to keep the selected aspect ratio.
 
Aspect ratio
Select a suitable aspect ratio size from the list. There you'll find some commonly used sizes to quickly change the proportions of the frame.
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Rotating images
 
Open the Rotate tab.

Use the buttons on the Rotate and Flip tab to rotate the image by 90 degrees or to mirror the image.

 Rotate your photo 90° counterclockwise

 Rotate your photo 90° clockwise

 Flip your photo horizontally (left to right)

 Flip your photo vertically (upside-down)

 
Straighten images
The Straighten slider rotates the image up to 45° either way.

 
Auto leveling
Click the Auto Leveling button to straighten the horizon automatically.
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Level tool
1.  In your photo, find a straight horizontal or vertical line. It can be the horizon, the side of a building, or any other lines that are parallel or
perpendicular to the horizon.
2.  Now, click the Level Tool and trace that line on your image. Once you've traced the line, the image will be automatically rotated to make
that line precisely horizontal or vertical.

Movavi Picverse

Resizing images
 
Tip: If you intend to make other edits to the photo, do them before resizing it since the image quality will be preserved better. Also, we
recommend that you save a copy of the image before resizing in case you need it later, especially if you plan on printing out the image.
 
Open the Resolution tab.

1.  First select the measurement unit in the box on top of the tab: pixels, percent, centimeters, or inches.
2.  Set new dimensions for the width and height. You might see significant visual distortions of the image after resizing, so to prevent this,

enable the Keep aspect ratio  option. The icon will turn into a closed lock.
If you need to raise the resolution of your image, select the AI enlargement option. It will help you enlarge the photo without any quality
loss.
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3.  Or select one of the commonly used sizes from the preset list.
4.  Click Apply to resize the image.

Movavi Picverse

Text
 
1.  Click the Text icon to switch to the Text tab.

2.  On the Text tab, click the Add Text button. A new text area will appear in the photo.

3.  Enter your text in the Add Text field.
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4.  Set the font, size, and color for your text.

5.  Drag the text area with your mouse to place it inside the image. To rotate the text area or resize the text, drag at the  resizing button in
the bottom right-hand corner of the text area.

6.  Set the background and frame color, position of the text, and add a text warp if needed.



 

47

7.  Click on the Decorations button to choose additional decorations from our library.

Removing text

Select a text area and click the  button in its upper left-hand corner to remove just one caption.
 
Tip: you can edit several objects at a time. Select them by holding Ctrl and clicking with your left mouse button. Click the group of objects with
your right mouse button, and select Ungroup objects to cancel the selection.
Movavi Picverse

Saving images
 
1.  Click Save on the top panel. From there you can select to save a file to your computer or to upload it to Google Drive.

Or you can open the File menu and click Save to rewrite the previous image. To save the image under a different name, click Save As…
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2.  You will see a saving window.
•  Choose where the file will be stored in the Save as field. Click Browse to open Windows Explorer.
•  Choose the File type from the list.
•  The Show file in folder after saving option automatically opens the output folder in Windows Explorer after saving.

3. (optional) Click the Advanced settings in the saving window to open the additional settings.
•  Add an author and a comment to your photo.
•  Select the Remove all metadata checkbox If you don't want the file to store any additional information
•  Select the Remove GPS data checkbox if you don't want the photo to store any location information.
4. Click Save.

Movavi Picverse

Saving to Google Drive
 
1.  On the top panel, click Save — Google Drive.
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2.  Click Log In to log in to your Google Drive account. Then in a browser window, select a user you want to use and click Allow.

3. On the left, select a folder where you want to save your photo. Name the file, choose who can access it and its format. Select the Save to
computer option and choose a folder if you also want to save the photo to your computer.
4. Click Save.

Movavi Picverse
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Changing image format
 
1.  After you've opened and edited an image, click Save on the top panel and then click Save below.

2.  Open the File type box and select the format you need.

Some formats also allow you to set the image quality and compression method.
 

JPEG Quality
Drag the slider to a desired quality level. Lower quality allows you to compress the image to smaller file size, but will probably not look as
good.
 
TIFF Compression
Select the preferred compression method:
•  Uncompressed: no compression method will be used. The image will be much larger in size than its compressed copies, but uncompressed
images with large resolutions may be processed faster by some software.
•  PackBits: offers less compression than LZW but is the most widely supported compression method, especially on Apple software.
•  LZW: compresses the image to about half size.
•  ZIP: best for working with 16-bit images and average for 8-bit images.

 
3. Choose where to save the new file and give your file a name.
4. Click Save.
 
Tip: If you make any edits after saving the file in a different format, you will be working with the new file.
Movavi Picverse

File information
 
To see a photo's media properties, go to the File menu, and choose File Information.



 

51

Or press the File Information icon  at the bottom of the window.

A File Information window will appear. Here you can find the file size, dimensions, format, and other properties of the original file. Knowing
certain information about a file will allow you to better understand which settings are best for your photo.

Movavi Picverse

Image size and quality
 
Even though image files rarely take up more disk space than videos or other media files, a large photo collection can quickly fill up your hard
drive if you save all photos at the maximum size and quality. In this section, you will learn how to manage image file size. Several properties
define image file size.
 



 

52

Image size in pixels
The larger the image, the more pixels it will be made up of, and the more data will need to be stored. The number of pixels also defines image
resolution for printing and affects the maximum level of detail you can achieve for a print of a specific size.
 
To reduce file size, you can resize the image. However, this comes at a cost: the smaller copy will look just as good, but if you want to print
out the image or use it as wallpaper, the smaller file will look considerably worse than its original.
 
Let's see how much disk space you can save by resizing images. Below are the file sizes for one image (here, you see a scaled-down
preview), and the difference is impressive. Resizing a large image to a viewable 800x600 size makes the file size over a hundred times
smaller.
 

Dimensions File Size
7899 × 5924 px 27,6 MB

800 × 600 px 168 KB

 
If you want to upload previews of your images to the web, or share photos in web albums, resizing the photos will most likely be a good idea.
The upload will be faster, and if you have a storage limit, it won't be filled up as fast as if you uploaded the images at their original size.
 
Tip: Don't scale up small, low-quality images. An image with small dimensions does not have enough data in the file to allow any program to
fully restructure the quality of a larger size image. If you size them up, you will only be wasting disk space without any quality improvement.

 
Read our resizing guide
 
Image complexity
Image complexity plays a large role in file size. Due to image compression specifics, images with different content but identical size and
format will differ in file size because of the details that will need to be preserved. For example, if you save a large image of a purely blue
background, some compression methods will only need to store which color fills the whole image, while for a picture of a flower, all the small
details will be stored to avoid quality loss.
 
Note the images below. They are of identical dimensions and are both saved in JPEG format. One image is a photo of a complex and colorful
flower, while the other is a plain blue background. The second image's file size, having to encode less data, is 48 times smaller than the first!
And while you can't simplify your photos to a single color, keep in mind that some images will naturally have a larger file size than others.
 

425 × 282 pixels

144 KB 2,98 KB
 
Format and compression method
A compression method can be seen as a shorthand writing system for image editing software, where it can write all the data of your image
into less space, and then decipher the shorthand to recreate the image on your screen when you open the file. Most image compression
methods do not store all of the image's data pixel by pixel since it would take significantly more disk space. Instead, the image compression
algorithm finds a way to pack this information by finding identical parts and only recording those same parts once, or by throwing away
some data that it finds less important. Different formats have different compression methods, and choosing the best format largely depends
on the type and purpose of the images.
 
Lossless formats: some formats can store the image without losing any data, meaning that the quality of the image will not decrease when
you save it. These formats can store the image either at its full size or use a lossless compression method that will pack the image into a
smaller file yet retain the original quality. No matter the compression level, these files are rather large but offer the benefit of higher quality
and sharper images, which is especially important for text images and logos.
Common lossless formats: PNG, TIFF, BMP
 
'Lossy' formats: other formats allow you to save the images into smaller files, but they compress images at the expense of some quality. For
large photos, the trade-off is usually justified, as the human eye will probably not notice the difference at low compression levels. However,
when manually adjusting the quality of 'lossy' formats, such as JPEG, it is important not to set the quality too low to enjoy the image.
The most common 'lossy' format: JPEG
 
When you change an image's format, note that saving it to a lossless format will not improve its quality but only preserve the existing data.
Likewise, if you change an image from a lossless format to a 'lossy' one, some data will inevitably be lost to compression.
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Saving files in different formats
Movavi Picverse

Printing images
 
How to print images in Movavi Picverse
1.  Open the File menu and choose Print.
2.  Choose the printer you want to use for printing the photo.
3.  Click Settings to open the settings for the selected printer. The settings will vary depending on your printer's software, but generally, you
can choose paper size, orientation, and color options.
4.  Choose the number of copies that you want to print. If this is your first time printing a photo, you may want to first print only one sample
copy to make sure you have set up everything right.
5.  Click Print to begin printing!
 
Image printing guidelines
Follow these guidelines to ensure the best possible print quality.
1. Make sure the image is large enough for printing on the selected paper size, and conversely, choose the right paper size for your images.
If you print out small images on large paper, you may find that you can see individual pixels or that the image is not smooth enough on print.
Before taking the photos you want to print, use a camera with a high megapixel count. Make sure that it is set to the highest available quality
(some cameras allow you to shoot smaller images than the camera's maximum size), and provide good lighting conditions to minimize
noise.
 
The larger the original photo, the larger a print size you can afford without losing crispness and quality. The standard for printing images is to
have at least 300 pixels per inch of the photo paper. The following table shows the correlation between image size and its printed size when
printed at 300 pixels per inch (~118 pixels/cm). You can use it to match paper size to your image size and vice versa.
 

Camera megapixels Image size in pixels Printed size in inches Printed size in centimeters
2 1600 × 1200 px 5" × 4" 13 cm × 10 cm
3 2048 × 1536 px 7" × 5" 17 cm × 13 cm
4 2464 × 1632 px 8.2" × 5.4" 21 cm × 14 cm
5 2560 × 1920 px 8" × 6" 21 cm × 16 cm
6 2816 × 2112 px 9" × 7" 24 cm × 18 cm
8 3264 × 2468 px 11" × 8" 28 cm × 21 cm

10 3872 × 2592 px 12.1" × 9.1" 33 cm × 22 cm
12 4000 × 3000 px 13" × 10" 34 cm × 25 cm

 
If you didn't find the necessary size in the table, you can easily calculate the printed size in inches by dividing the width and height in pixels
by 300. Likewise, to find out the minimum number of pixels for a specific print size, multiply the width and height in inches by 300 to get the
image dimensions in pixels.
 
2. You do not need to downsize the image before printing: the software will automatically fit the image onto the selected paper size.
Decreasing the image will only reduce quality.
 
3. If you need to crop unwanted parts of the image, make sure that the result is not too small. If you have a very large image, you can use
the crop function to zoom in on objects in the image, but keep in mind that the output image size must be large enough for printing. You can

check the image size in pixels by clicking the File Information button on the bottom panel: .
 
4. Use a high-quality printer for printing out your photos. These simple guidelines will help you choose a printer:

•  Inkjet printers are much better at printing images than laser printers. Dye sublimation printers are considered the best for printing
photos, however, they are quite rare and can only be used for photo printing.
•  Check the printer's dots per inch (DPI) resolution: the higher the DPI, the higher the quality prints it will be able to produce. For photo
printing, make sure that the printer has at least 300 × 300 DPI.
•  Generally, a dedicated photo printer will produce better results than a general-purpose multifunction printer of the same price range.
•  Some printers may produce colors different from the original because of the way they convert RGB color (the color scheme you see on
your monitor) to CMYK color (used for printing).
•  Be aware of your printer's maximum print size; many consumer printers only print photos up to 8 by 10 inches (20.32 × 25.4 cm). You
should find this information on the packaging or in the printer's user manual.

 
5. Use high-quality photo paper. There are different kinds of photo paper that may work differently depending on the content of your image.
For example, glossy paper is better at reproducing bright colors, while matte paper is more suitable for portraits. Also, make sure that the
paper matches your printer type (i.e., laser or inkjet).
 
Calibrating your display
The colors you see in print may be slightly different than those you see on your display due to LCD monitor specifics. You can try to calibrate
your display for better previewing:
1.  Open the Control Panel.
2.  Type "Calibrate display" into the search box.
3.  Click Calibrate display color. This requires administrator permissions.
4.  Follow the on-screen instructions to calibrate your display.
Movavi Picverse

Program settings
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To open Movavi Picverse preferences, click the Settings button at the top of the window to open the settings menu. There, click Preferences.
You will see the settings window.

 
General settings

•  Language — to change the interface language, select the necessary language from the list and click OK to apply the changes.
 
•  Automatically check for updates — select this option, and you'll be notified whenever a new version is available. Updates within your
version are free (for example, 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.
 
•  Launch the program in editing mode — select this option to skip Gallery and start the program in editing mode.
 
•  Save extended logs for troubleshooting — in case you experience trouble using the program and contact our support team, they might
ask you to collect logs. The logs contain the program's actions for some period of time, as well as important error reports and descriptions.
Extended logs give the most amount of information, which may be essential to solving your problem.
 
•  I give consent to send anonymous usage stats to Movavi — checking this box will allow the program to send usage statistics to our
development team, enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The
data contains no personal information, will not be disclosed to third parties and will be used for software improvement purposes only.
Learn more about how we use the statistics
Read our Privacy Policy
 
Files settings

http://www.movavi.com/mip.html
http://www.movavi.com/privacy.html
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•  Directory for temporal files — temporary files that Movavi Picverse creates while working with your photos are stored in a default folder.
Click Browse and choose another folder for temporary files. And click the reset icon to reset your folder to default.
 
•  How many days to keep photos in the bin? — all deleted files are kept in the recycle bin for 30 days before being deleted completely. You
can change this period by setting another number in this field.
 
•  Show the last edited file on the start page — when you open the program after you've worked on your photos, you will see the last edited
one on the start page of the editing mode.
 
Movavi Picverse

Keyboard shortcuts
 
For faster editing, the most commonly used actions are bound to shortcuts or hotkeys.
 
To open the list of shortcuts
1.  Open the Settings menu.
2.  Select Keyboard Shortcuts.
 
To change a shortcut
1.  Double-click the field next to the action you want.
2.  Press the key or key combination you want to use.

To reset all the keyboard shortcuts in a group to their original state, click the reset icon .
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Movavi Picverse

Help and support
 

Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team,
and we'll help you right away.
If you run into a problem, please describe it in as much detail as possible. Any screenshots, log files, or information
about your system will allow us to help you faster.
 
Join live chat
Submit a support ticket

 
Frequently asked questions
How to remove trial restrictions?
What are the system requirements for running Movavi Picverse?
How to update the graphics card drivers?
Movavi Picverse

Supported formats
 

 
Format

 
Input

 
Output

BMP
DPX
EXR  

GIF (non-animated only)  
JPEG

JPEG 2000  
JPEG-LS  

PAM  
PBM
PCX
PGM
PIC  
PIX  

PNG

PPM
PTX  
RAW  

Sun Rasterfile  
TIFF

https://vue.comm100.com/ChatWindow.aspx?siteId=27345&planId=614b4c00-0000-0000-0000-008e00006ad1
https://movavi.freshdesk.com/en/support/tickets/new


 

57

WebP  
XFace  
XWD  

 
Movavi Picverse

System requirements
 
The minimum system requirements represent the lowest hardware specifications that are guaranteed to run Movavi Picverse. If your
computer meets the recommended configuration, then Movavi Picverse is sure to run smoothly on your computer.
 
Operating system Microsoft® Windows® 7/8/10 64-bit with up-to-date patches and service packs installed

Processor Intel® i5 or higher, AMD®'s equivalent to Intel® i5 or higher, or compatible processor

Display resolution 1280 × 768 screen resolution, 32-bit color
RAM 6 GB

Available disk space 500 MB available hard disk space for installation, 5 GB for ongoing operations

 
Images with dimensions greater than 6000 × 8000 pixels might not be processed correctly.
Movavi Picverse

Updating graphics card drivers
 
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics
card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when
a driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure the stable
performance of applications and games on your computer.
 
Step 1: Find your graphics card manufacturer
1.  Right-click your desktop and choose Screen Resolution.
2.  In the Screen Resolution settings window, click Advanced settings.
3.  This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type
section. Note the full name of the graphics card somewhere for later.
 
Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There,
look for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility
that will automatically find the necessary driver.
NVIDIA download center
AMD download center
 

Warning:
Only download drivers from the official manufacturer's website. Third-

party websites offering driver downloads may contain malware.
 
Step 3: Install driver
Once the file is completely downloaded, run the installation file, and follow the onscreen instructions to install the driver on your system. Your
display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.
 

 
Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows
you to optimize your computer's graphics performance.
 
1.  Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please
try the method above.
2.  In the Drivers section, click the Check for updates button to find the latest drivers.
3.  When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and
install the necessary driver for your system.

http://www.nvidia.com/Download/index.aspx?lang=en
http://support.amd.com/en-us/download
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Updating AMD® or ATI® Driver
1.  If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
2.  Download the auto detect utility and run it when the download has finished. 
Auto Detect Utility
3.  The utility will then automatically find your graphics card and help you download and install the right driver for your system. If the utility
fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads page and
download the driver.
4.  After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
5.  After the driver has been installed, it is recommended that you restart your computer.
 

If none of the above steps have helped, feel free to contact our support team by creating a ticket at the Support Center or joining live chat.
 
If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have
encountered. This will help our support team specialists solve your problem quicker.
Movavi Picverse

How to collect logs
Providing your log files when you contact support can help us solve your problem faster. The logs contain the program's actions for some
period of time, as well as important error reports and descriptions. The log files do not contain any personal information.
 
Note that extended logs give the most amount of information, which may be essential to solving your problem. To save extended log files,
go to Preferences and check Save extended logs for troubleshooting.

Once you’ve done that, repeat the same actions in the program that previously caused errors. After that, you need to collect logs and send
them to us.
1.  Download a utility which will collect logs.

http://support.amd.com/en-us/download
http://www2.ati.com/drivers/auto/autodetectutility.exe
https://movavi.freshdesk.com/en/support/tickets/new
https://vue.comm100.com/ChatWindow.aspx?siteId=27345&planId=614b4c00-0000-0000-0000-008e00006ad1
https://cdn.movavi.com/dl/support/get_movavi_logs.exe
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2.  Launch it and wait until the log collecting process ends. Once the process is complete, the folder with the movavi_logs.7z archive will
open.
3.  Send this archive to Movavi Support Center.
 

https://movavi.freshdesk.com/en/support/tickets/new
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